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Redacting In Adobe Acrobat Pro 2017. Redaction is the permanent deletion of data from documents. In the past, markers were used to black out information on documents. These days, it simply doesn’t make sense to print out a document to redact it. The process is slow, expensive and inefficient.
Law firms, government agencies and corporations around the world rely on Adobe Acrobat to safely and permanently remove content from the data stream of the documents. Adobe first offered redaction tools starting with Acrobat 8 and redaction capabilities have continued to improve with each
new release. New Redaction Features in Acrobat X Repeat Redaction Mark across Pages Useful for redacting headers and footers from documents Right-click to apply Exemption Codes Add case codes and privacy codes as overlay text to redaction marks Ability to apply multiple Exemption
Codes Multiple exemption codes may be listed on a redaction mark Partial Pattern Redaction Use this feature to mark part of a pattern for redaction. For example, you could mark part of a Social Security Number or Credit card number. Useful for cases where you need to identify individuals in part
of a case without revealing personal identifying information. Set Color and Opacity for Redaction Marks In Acrobat 9 and earlier, redaction marks (during review, prior to being applied) always displayed with a red border. In Acrobat X, you can set the appearance to be, for example, 50% red with no
outline. Comments Panel The Comments Panel now indicates the Overlay Text or Exemption code for the redaction mark So, you want to redact some files. How do you get started? To help, I bring you Rick’s Guide to Using Redaction in Acrobat X Pro. Topics Covered Redaction Workflow
Adding, Previewing and Deleting Redaction Marks Changing the Appearance of Redactions Working with Multiple Redactions Applying Redactions to permanently delete content Using an Action to Automate the Redaction Process Redaction Workflow – Important! It’s critical to understand the
redaction workflow in Acrobat which is: Mark items to be redacted Review marked items Apply Redactions (Removes the information from the document) You must Apply Redactions to Remove Information Marking items merely indicates that you want to remove the information. You MUST Apply
Redactions to permanently remove information from the document. Suggested Workflow Step 1: Set Redaction Preferences Automatically Copy Text into the Sticky Note for a Redaction Redactions exist as a type of annotation until you apply them which permanently removes the information. This
preference is handy during review since it copies text into the sticky note. Choose Edit—> Preferences (Windows) or Acrobat—> Preferences (Mac) Select the Commenting category from the list on the left: Enable the check box labeled “Copy Selected Text into Highlight, Crossout, and Underline
comment pop-ups Click OK For example, let’s say you wanted to redact a date. When you select text using the Mark for Redaction tool, the text will automatically be copied into the sticky note: Step 2: The Basics: Adding, Previewing and Deleting Redactions The tool you will use for almost all of
your work is the Mark for Redaction tool. To find the Mark for Redaction tool . . . Open the Tools Panel Twirl open the Protection section Select Mark for Redaction Context Sensitive The Mark for Redaction Tool cursor changes depending the content to be redacted. To Redact Text Select the Mark
for Redaction tool When you hover over text, the Mark for Redaction tool becomes a text selection cursor. Select the text to mark it for redaction. Tip: Did you select too much? Hit CTRL-Z to undo the redaction. To Redact a Graphic or Image Select the Mark for Redaction Tool Place the cursor
over an image or if no objects are present, across hair cursor (+) appears. Draw a rectangular selection area to redact. Anything found within the area— images, text, vector objects— will be “cut out” and redacted. Force an Area Redaction Sometimes it can be difficult to select text properly. You
can force Acrobat to present the crosshair for an area redaction by holding down the CTRL key. Previewing a Redaction Using the Mark for Redaction tool, you may preview the redacted item. Select the Mark for Redaction tool Hover over a redaction mark to preview it Deleting a single Redaction
Mark Until you click the Apply Redactions button, the redaction marks are editable. To delete one, hover over it and click. You’ll see some subtle animation around the edges. Hit the DEL key to delete the redaction. Changing the Appearance of Redactions By default, redactions appear as solid
black rectangles. The default appearance serves most folks just fine, but may be customized: To change the appearance of a redacted item, right-click and choose Properties. . . You may set a number of options such as… Redaction Color Overlay Text Overlay Text Color and Repeat To change
the properties of a Redaction mark Select the Mark for Redaction tool Hover over the redaction mark you wish to change Right-click and choose Properties The Redaction Properties window is straightforward. Options below are referred by number: Set the color of the redaction here. This is the
appearance of the redaction after it is applied. You may also choose “no color” as an option. You may have overlay text on top of the redaction. Choose typeface for overlay text Set font size for overlay text Auto-size scales the text to fit the width of the redacted area Enable to repeat overlay text
on the redaction mark Set alignment of overlay text Type in custom text to appear on top of the redaction. Note: Will only be available if “Use Overlay Text” is checked Enable to repeat the text over the redacted area This field displays Redaction Codes entered using the Code Sets below (11).
Note: You cannot type into this field Redaction Codes. Redaction codes pre-defined sets of text used to denote the reason or statute under which the redaction was made. Acrobat Pro includes two pre-populated sets— U.S. FOIA (Freedom of Information Act) and U.S. Privacy Act. You can also
create and save your own sets. Set the Outline Color for the Redaction Mark Sets the color of the comment mark before the redaction is applied To change the default appearance of all redaction marks: Use the Mark for Redaction tool to create a redacted item Right-click and choose Properties to
change the appearance. Click OK. Right-click on the item and choose “Make Current Properties Default” Working with Multiple Redactions (Delete or change Properties) Acrobat’s Comments Panel offers a list view of all of the Redaction marks in the document. From the Comments Panel, you can
delete or change the properties of many redaction marks at a time. Open the Comments Panel, then twirl down the Comments List section Select one or more comments, then right-click and choose Properties Working in the Comments Panel You can select a comment (Redaction mark in this
case) by clicking on any of the items in the list.. Hold down the CTRL key if you need to select a discontinuous range of comments. To select all of the redaction marks: Select the first item in the list Scroll to the bottom of the list Press SHIFT and select the last comment. To delete a Redaction
mark: Hit the DEL key (or choose Delete from the pop-up menu) to delete any selected comments. To change the properties of one or more comments Make a selection then, right-click and choose Properties. Search and Redact Acrobat X Pro Search and Redact feature may be used to search
intelligently for: Single text strings Multiple text strings Patterns such as Social Security numbers . . . in a single document or across multiple documents. Open the Tools panel Twirl down the Protection section Click Search and Remove Looking at the Search and Redact Window The Search and
Redact window offers a few options: The Arrange Window button conveniently sizes the Search and Document windows You can search in the front most (current) document or point to a whole folder of documents. Set the search scope for single or multiple words, or patterns Enter text to search
for (only available for Single word option) Determine whether you will search for whole words or if capitalization matters Searching for a Single Word Click Search and Remove Text in the Protection Panel In the Search window, click Arrange Windows if necessary In the Where would you like to
search area, select In the current document or to browse to folder of files to perform cross-document search. in the Search for area, choose Single Word or Phrase Enter your text in the search field Click Search and Redact Working with the Results Once the search is complete, the results window
opens. Clicking Check All will add a mark to all the words found You can also individually check any of the results. If you click on the result, you can preview the word in the PDF Click Mark Checked Results for Redaction to mark the words found Searching and Marking Multiple Words Acrobat X
can search for and mark multiple words simultaneously. Here’s how: Click Search and Remove Text in the Protection Panel In the Search window, click Arrange Windows if necessary In the Where would you like to search area, select In the current document or to browse to folder of files to
perform cross-document search. in the Search for area, choose Multiple Words or Phrase The Words and Phrases to Search and Redact window opens – Enter each word you wish to search for and click Add (Optional) Import a list of words Click OK Acrobat will search through the document(s)
and place a redaction mark on all words found Using Pattern-based Redaction Acrobat can use pattern recognition to find information that varies such as: Phone Numbers Credit Card Numbers Social Security Numbers Email Addresses Dates Here’s how to use patterns to find this type of
information Click Search and Remove Text in the Protection Panel In the Search window, click Arrange Windows if necessary In the Where would you like to search area, select In the current document or to browse to folder of files to perform cross-document search. In the Search for area, choose
Patterns Select the type of information you want to find: Click the Search and Redact button The Search window displays the results: A) Click to begin a new search if you did not find what you were looking for B) Click to save a PDF or CSV of the search results C) Click Check All to create a
redaction mark for each pattern found D) Click on any item in the list to review the found pattern in the document window.D) Check any item to make a mark for selection E) Enable to mark part of the pattern (see below) F) Click Settings to change the marking options G) Click Marked Checked
Results for Redaction to mark them in the documentMarking Part of a Pattern To identify individuals in a case without breaching confidentiality, you may wish to mask part of a found pattern. Using the settings at right, the first characters of a Social Security number are masked. This allows us to
identify individual based on the remaining digits:  Step 3: Review Redactions It’s important to carefully review each page of your document, especially for scanned documents. Fortunately, redactions in Acrobat are managed using familiar commenting and annotation tools. Thus, you can: Add
notes and comments to Redacted items and send them to another Acrobat Professional user to review, reply to or change Participate in a Shared Review of a document. If other users have Acrobat Pro, multiple people, in real time, may indicate redactions. Summarize comments and notes
attached to redacted items as part of a review or archival workflow Approve, reject or delete items to be redacted using the Comments Panel To add a note/comment to an item marked for redaction, do one of the following: Right-click on the item and choose “Open Pop-up Note” Double-click on
the item To view the Comment panel, choose one of these methods: Open the Comments Panel, then twirl down the Comments List section Create a new Document which Summarizes Redactions If you were headed to meeting with the other side, and you expected some challenges to your
privileged and redacted documents, you might want to create a summarized version of your redacted documents to take with you. This process creates a new, consolidated PDF. Redaction annotations are displayed as call-outs on the document: To create a summarized document: Open the
document containing your redaction marks. (You need to run this step before you apply redactions.) From the Comments Panel- Comments List, choose the flyout menu and choose Create Comments Summary The Summarize Options window will appear. I suggest choosing the second option:
Click the Create PDF Comment Summary button. Need to create a Privilege Log?Go to the Actions Exchange on the Acrobatusers.com website to download the free Create Comment Summary Action. This Action reports on your marked files and can generate a spreadsheet file of all of your
redactions. Step 4: Make Redactions Permanent (Apply Redactions) Applying Redactions in Acrobat permanently removes the information from the document once you save it. To apply redactions: Click the Apply Redactions button in the Protection Panel A warning window appears. Click OK The
Redactions are applied. Next, you will see another warning message prompting you to examine the document for metadata. Click the Yes button. The Examine Document panel opens. Examine Document finds hidden information such as metadata, hidden text, comments, etc. that could lead to an
accidental disclosure. Note that the hidden OCR text layer can be removed, too. Click the Remove button. Choose File> Save If you set the Preferences in Step 1, Acrobat will rename your file automatically when you go to save it: Use an Action to Automate Redaction Acrobat X Pro Actions allows
you to automate several steps of the Redaction process. I’ve built a legal-specific Action to help automate the process. Rick’s Redaction Action performs the following steps: Prompts you to locate the documents you wish to redact Converts them to PDF (for supported file types like Word, Excel,
etc.) OCRs the document (optional) Prompts user to redact the document Applies the redactions Prompts for metadata removal (optional) Renames the file with the _redacted.pdf suffix Saves the file as an Acrobat 5 level file (PDF 1.4) which is compatible with court filing systems Download the
Action Redaction_Action.pdf(700K) Hint: Right-click and Choose Save Target As . . . to save to your desktop Install and using the Action Follow the instructions in the PDF to extract and install the Action. The PDF also contains full instructions for using the Action. Below, I’ve included some
abbreviated instructions so you can get a sense for how the Action works. Create a folder on your desktop or other location. e.g. “Redacted Output” Open the Tools Panel and go to the Actions Wizard section. Click on Rick’s Redaction Action The Action Confirmation window appears. Click the
Next button. The Select Files window appears. Click the Add Files button at the top of the screen and locate the files you need to redact. Once you have added the files, click the Next button. Find the folder you created in Step 1. This folder will be the destination for the redacted documents.
Acrobat will open the first document in the list. You’ll be asked if you want to OCR the document. Click OK if you do. Acrobat automatically select the Mark for Redaction tool. – Make any redactions necessary on the document. – Click the Next Step text in the yellow Action notifier Acrobat will
continue to walk you through the various steps of the Action for each document in your list. Don’t like the Action? Change it . . .Modifying the Action is easy. I’ve included instructions in the PDF documentation. Final Thoughts Keep in the mind the following when taking on projects that require
redaction: DO NOT FORGET TO APPLY REDACTIONS! Simply marking text and graphics does not actually remove it.  Using Acrobat X Pro, you can use Actions to automate much of the redaction workflow such as: Prompting the user to redact multiple documents in sequence Apply Redactions
Word List Redaction Search and Redact will only find text in searchable documents. OCR documents first. Even so, since OCR is an imperfect process, carefully review scanned documents. Carefully review all documents prior to submission in discovery. A two-person review team will catch many
more errors than a single person. Know your court rules and judges orders regarding redaction. Ask the clerk of the court for clarification if you need more information. Don’t Skip the Examine Document Step Naive users may elect to cover up information in electronic sources and mistakenly
believe it is redacted. The Examine Document function can detect and fix these issues. Follow these steps to use the Redact tools of Adobe Acrobat DC to remove sensitive images and text before you share your PDF. The Remove Hidden Information feature allows you to search and redact
hidden content from the PDF. ... Adobe Acrobat 2017 Adobe Acrobat DC. ... (Acrobat Pro DC) Click Tools > Redact. The Redact toolset is displayed in ... 10/11/2016 · How to redact in Adobe Acrobat. Note: Other PDF software is available. Check out our review of some of the best. The most
recent version of Adobe Acrobat offers the quickest and simplest method to redact a document. It really only takes a few minutes. Step one. First, open the document you wish to redact. Go to the Tools menu, then select ... 07/02/2018 · Work has just purchased a license for Adobe Acrobat 17 Pro,
this was to enable us to redact sensitive information. I have looked everywhere for help to do this, but can't find help anywhere. I have been redacting documents in Adobe Acrobat 9 X Pro. However, I now want to mark and copy some text out of one of these documents. The redact text icon won’t
go away, and it only lets me mark text for redaction now! I have removed the Quicktools for redaction from my toolbar, but am stuck with the ‘mark for redaction’ cursor. Where is the Redaction Tool in Adobe Acrobat X Standard? I can't find the redact option in Acrobat X Standard to black out
confidential information in a pdf.
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